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Disclaimers 
Lattice makes no warranty, representation, or guarantee regarding the accuracy of information contained in this document or the suitability of its 
products for any particular purpose. All information herein is provided AS IS, with all faults and associated risk the responsibility entirely of the Buyer. 
Buyer shall not rely on any data and performance specifications or parameters provided herein. Products sold by Lattice have been subject to limited 
testing and it is the Buyer's responsibility to independently determine the suitability of any products and to test and verify the same. No Lattice 
products should be used in conjunction with mission- or safety-critical or any other application in which the failure of Lattice’s product could create a 
situation where personal injury, death, severe property or environmental damage may occur. The information provided in this document is 
proprietary to Lattice Semiconductor, and Lattice reserves the right to make any changes to the information in this document or to any products at 
any time without notice. 
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Acronyms in This Document 
A list of acronyms used in this document. 

Acronym Definition 

ASC Analog Sense and Control 

CPLD Complex Programmable Logic Device 

DDR Double Data Rate 

DLL Delay-Locked Loop 

DSP Digital Signal Processing 

EDA Electronic Design Automation 

FPGA Field Programmable Gate Array 

HDL Hardware Description Language 

I/O Input/Output 

IP Intellectual Property 

LSE Lattice Synthesis Engine 

PAR Place and Route 

PCS Physical Coding Sublayer 

PFF Programmable Functional Unit without RAM/ROM 

PFU Programmable Functional Unit  

PIO Programmable Input/Output 

PLC Programmable Logic Controller 

PLL Phase Locked Loop 

RTL Register Transfer Level 

STA Static Timing Analysis 

TCL Tool Command Language 

VCD Value Change Dump 
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1. Introduction 
The Lattice Semiconductor Field Programmable Gate Array (FPGA)/Complex Programmable Logic Device (CPLD) design 
flow is similar in conception and implementation to the Intel®1 FPGA design flow. At its core, a hardware description 
language (HDL) code of your register transfer level (RTL) can be imported into one of Lattice’s design software and then 
configured to one of Lattice’s FPGA. 

This document guides Intel FPGA designers familiar with the Intel® Quartus®1 Prime software, specifically version 20.1, 
in migrating existing designs to the Lattice Diamond® software specifically version 3.12 SP1. It also highlights some of 
the differences and similarities between the design flows of Quartus and Diamond. 

This user guide starts with an overview and comparison of the design software and a mapping of the tools and file 
extensions between the two. The next section compares the design flows of the design software. The succeeding 
sections provides a step-by-step walkthrough about the following: project creation and management, design entry, 
compilation flow, simulation, and programming/configuration. 

For more details on the Diamond design flow, refer to the Diamond video tutorials listed in Table 1.1. 

Table 1.1. Diamond Video Tutorial Links 

Title Description 

Diamond Overview 
This video overview briefly covers several new features and abilities such as the 
new user interface, design flow, and several tool views that are available. 

Diamond Installation Overview Preview of step by step installation process of Lattice Diamond software 

Diamond Licensing Overview Instructional video on obtaining license and installation 

Setting up a Floating License Tutorial 
Instructional video on how to setup a floating license on a server and how to setup 
environment variables on a client machine in order to access the server license. 

Diamond Key Concepts 

This video discusses the structure of Diamond projects and the use of 
implementations, strategies, and folders within projects. 

Additionally the video discusses shared design memory use, and context sensitive 
views. 

Diamond Design Flow Changes 
This video describes the design process flow and the use of the Process view, File 
List view, and Run Manager view. 

Diamond Timing Analysis Overview 
This video describes the management of the Timing Analyzer files, the new Timing 
Analyzer UI, and how to make timing constraint changes and generate new timing 
results. 

Diamond Power Calculator 
This video describes the management of the Power Calculator files and the 
behavior of the Power Calculator view. 

Diamond Reveal™ Hardware Debugger 
This video describes the management of the Reveal debug files and the new 
Reveal Analyzer waveform changes. 

Diamond Simulation Flow 
This video describes the simulation features provided with the software and their 
basic usage. 

Diamond TCL Scripting Support 
This video describes the available TCL dictionaries and how to run TCL commands 
from the user interface or the TCL console. 

Diamond Programmer This video describes how to use it from the user interface or outside of DIamond. 

1Intel, the Intel logo, and Quartus are trademarks of Intel Corporation or its subsidiaries. 
Intel Quartus software is used to show the differences and similarities between the design flows of Quartus and Lattice Diamond software. 
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2. Design Software Overview 
A design software is required to be able develop and implement FPGA/CPLD designs for market usage. The design 
software must have the following characteristics to reduce the design’s time-to-market:  

 Full-featured – Offers all necessary tools for design development.  

 High-performance – Performs powerful optimizations and analyses.  

 Intuitive user interface – Provides the best user experience with a graphical user interface that is both modular and 
wizard driven. 

The Diamond software has these characteristics, making it one of the best industry solutions for low-end to mid-range 
FPGA designs. The Diamond software integrated tool environment provides a modern, comprehensive user interface 
for controlling the Lattice Semiconductor FPGA implementation process with support for the older Lattice FPGA device 
families as compared to Lattice Radiant™ Software, which supports relatively newer FPGA device families. 

The Diamond software uses an expanded project-based design flow and integrated tool views so that design 
alternatives and what-if scenarios can easily be created and analyzed. The Implementations and Strategies concepts 
provide a convenient way for you to try alternate design structures and manage multiple tool settings. System-level 
information—including process flow, hierarchy, and file lists—is available, along with integrated HDL code checking and 
consolidated reporting features. A fast Timing Analysis loop, ECO Editor, and Programmer provide capabilities in the 
integrated framework. The cross-probing feature and the shared memory architecture ensure fast performance and 
better memory utilization. The Diamond software is highly customizable and provides TCL scripting capabilities from 
either its built-in console or from an external shell.  

Most of the capabilities available in the Quartus software are available as well in the Diamond software. However, the 
terminology of the individual tools, features, and file formats may differ from one software to the other. Table 2.1 lists 
some of the tools, features, and file formats in Quartus and its corresponding name in Diamond. 

Table 2.1. Mapping of Quartus and Diamond Tools, Features, and File Extensions 

Description Quartus Tools Diamond Tools 

Optimization or implementation settings Compiler settings Design strategies 

Design entry 

HDL file 

IP catalog 

Schematic editor 

HDL file 

IPexpress or Clarity Designer 

Schematic editor 

Design constraints 
Prime Assignment Editor 

Timing Analyzer Text Editor 

Spreadsheet View 

LDC Editor 

Synthesis Tools 

Precision Synthesis 

Synplify® 

Synplify Pro® 

LSE 

Synplify Pro 

Tools Comparison 
RTL Viewer 

Technology Map Viewer 

Netlist Analyzer 

Technology Viewer 

Place and Route Tools 
Quartus Fitter (Plan, Early Place, Place, 
Route, Retime and Finalize) 

Place and Route (PAR) 

Supported Simulators 

Aldec Active-HDL™ 

Aldec Riviera-PRO™ 

Cadence® Incisive® 

Synopsys® VCS® 

QuestaSim 

Mentor Graphics® ModelSim 

Synopsys VCS, Cadence NC-
Verilog, Cadence NC-VHDL, 
Cadence NCSim, Aldec Riviera 
Pro, Aldec Active-HDL, 
Questasim, and Mentor Graphics 
ModelSim 

Simulation Levels 
RTL Simulation 

Gate-Level Simulation 

RTL Simulation 

Post-Route Gate-Level Simulation 

Post-Route Gate-Level+Timing 
Simulation 

Power Analysis 
Power Estimator (EPE) and Power 
Analyzer 

Power Calculator 

On-chip debug tool Signal Tap II Logic Analyzer Reveal 

A tool for programming hardware Programmer Programmer 

http://www.latticesemi.com/legal
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Description Quartus Tools Diamond Tools 

Project file extension .qpf + .qsf .ldf 

IP configuration file extension .qip .sbx 

Soft processor development and generator Platform Designer Lattice Propel™ Builder 

Soft processor Nios® II RISC-V 
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3. FPGA Design Flow Overview 
When creating designs for Field Programmable Gate Arrays (FPGAs), Lattice and Intel software tools have similarities in 
terms of concepts, approach, and functionality. Lattice Diamond software framework technology uses the typical FPGA 
design flow (see Figure 3.1) that adheres to a sequence of steps, which initially requires setting up the design 
environment and ends with the generation of programming files that are used to program the hardware. In cases 
where Intel designers who are familiar with Quartus Prime would like to convert their existing Quartus designs to 
Lattice Diamond software environment, they can simply import their HDL (hardware description language) files to 
Lattice Diamond and begin implementing the project-based methodology (see Figure 3.2). 

 

Figure 3.1. Typical FPGA Design Flow Used by Intel Quartus and Lattice Diamond 
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Figure 3.2. Diamond Software Detailed Design Flow 
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4. FPGA Design Flow Tools and Views 
This section shows how Lattice Diamond and Intel Quartus software handle the FPGA design flow steps with various 
tools and views. 

4.1. Project Creation and Management 
In setting up the initial design environment, both Intel Quartus and Lattice Diamond provide a new project wizard 
functionality that guides you through the steps of project creation. The Diamond New Project option is shown in Figure 
4.1. 

The Diamond New Project wizard allows you to specify the project name and location, as shown in Figure 4.2, add 
existing source files as shown in Figure 4.3, select the target device for the design, as shown in Figure 4.4, and choose 
the synthesis tool, as shown in Figure 4.5. 

Note: All project settings may be changed at later stages in the design process. 

 

Figure 4.1. New Project Wizard 

 

Figure 4.2. Project Settings 
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In the Project Name page, the following items are available. 

Under the Project group: 

 Name – Name of project 

 Location – file path where the project is saved 

The following items are available under the Implementation group: 

 Name – Implementation name 

 Location – File path where the implementation is saved 

 

Figure 4.3. Adding Existing Source 

In the Add Source page, the following items are available. 

 Add Source – Adds HDL files, constraint files or testbench in the current project. 

 Copy source to implementation directory – Copies the source files added in the current project directory 

 

Figure 4.4. Target Device Selection 
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Figure 4.5. Synthesis Tool Selection 

Once the project is created, choosing the logical and consistent way of organizing each source file allows you to locate 
and modify them as needed. Both Quartus and Diamond support this practice by combining design sources into 
different categories and listing them in a Files/Files List View. In the Diamond software, the sources are categorized by 
different types and are identified with different icons. Bold items are active and are used when processing the design 
project. Grayed out items are not used, as shown in Figure 4.7.  

 

Figure 4.6. Lattice Diamond File List View 
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Refer to Table 4.1 for the file types and extensions.  

Table 4.1. Files Listed in Diamond File List View 

File  Description 

Project Name — 

Device Part Number — 

Strategies First four (wrench icon) are prebuilt and cannot be changed. Customize Strategy1 and 
others you add. 

Implementations Different versions of the design 

Input Files Design files such as Verilog and VHDL. Includes files for the design and the testbench. 

Synthesis Constraint Files SDC files used by synthesis tools 

LPF Constraint Files Lattice preference files used by map and place-and-route stages 

Debug Files Reveal files used in on-chip debugging 

Script Files Simulation Wizard files 

Analysis Files Power Calculator and Timing Preference files 

Programming File Files for programming a device, such as bitstream or JEDEC 

 

You can also see implementations listed in the File List view, as shown in Figure 4.7. 

 

Figure 4.7. Files Listed in Diamond File List View 

Diamond also offers different ways of involving a source file in your design. If you right-click on each source file, you are 
given different options depending on the file type.  
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These options are: 

 Excluding the file from implementation 

 Setting the design file as top-level 

 Removing the file for either or both synthesis and/or simulation 

 Checking for properties 

For implementation and strategy, you can create a different version or a clone of each, edit the properties, select the 
synthesis tool, and select the top-level unit. 

4.2. Design Strategy 
In Intel Quartus, you can modify the optimization settings by going to the Compiler Settings > Advanced Settings 
(Synthesis) or Advanced Settings (Fitter). Aside from modifying each setting, there are available optimization modes 
with pre-defined settings depending on the goal of the designer (i.e. power, performance, and area).  

In Diamond, this is equivalent to the design strategy. Diamond allows you to choose or create your own custom 
strategy for your implementation. A strategy is a collection of implementation-related tool settings or recipes for how 
the design is implemented.  

The Diamond software provides four pre-defined strategies:  

 Area – for area optimization; its purpose is to minimize the total logic gates used while enabling the tight packing 
option available in Map. 

 I/O Assistant – for I/O design; Its purpose is to help designers select a legal device pinout and produce LOCATE and 
IOBUF preferences for optimal I/O placement. 

 Quick – for initial quick run; its purpose is to allow the tool to get results with the minimum time using very low 
effort in placement and routing. 

 Timing – for timing optimization; its purpose is to achieve timing closure.  

It also enables you to create customized strategies, which can be edited, cloned, and removed. All strategies are 
available to all of the implementations, and any strategy can be set as the active one for an implementation. 

You can view the strategies on the File List View. Double-click on the strategy to tool settings for each of the steps of 
the design flow. 

 

Figure 4.8. Area Pre-Defined Strategy Settings 

For detailed information, refer to the Diamond Help or to Strategies (Chapter 5) in Lattice Diamond 3.12 User Guide. 
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4.3. Design Entry 
Lattice Diamond software supports HDL source files, IP catalog, and schematic entry as design entry methods. 

4.3.1. HDL Source Files 

In the Quartus software, you can create a new HDL source file by clicking on File > New, then select the HDL file to add 
to the design. In the Lattice Diamond software, you can do this similarly by clicking File > New or by right-clicking the 
Input Files folder on the File List tab. From the dropdown menu click on Add > New File. A New File dialog box opens 
where you can choose the HDL file type to add to the design. 

 

Figure 4.9. New File Dialog Box 

4.3.2. IPexpress and Clarity Designer 

In the Quartus software, the IP catalog is accessed by clicking on the IP Catalog icon on the toolbar. A pane is opened 
that can be detached into a window from which you can select through the different IPs. In the Diamond software, the 
IPs can be accessed either through the IPexpress or the Clarity Designer.  

Note: Clarity Designer is only available on the ECP5 device and CrossLink device families. 

You can click the IPexpress icon (or the Clarity Designer icon) on the Toolbar to open the corresponding window. 

 

Figure 4.10. IPexpress (or Clarity Designer) Icon 

On the IPexpress tab, you can select between installed IPs on local folder or can choose to download and install 
additional IPs from the IP Server. 

 

http://www.latticesemi.com/legal


Lattice Diamond Design Flow Overview for Intel Quartus Users  
User Guide 
 

© 2022 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.  
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice. 

18  FPGA-UG-02157-1.0 

 

Figure 4.11. IPexpress Window 

Similar to IPexpress, Clarity Designer provides a way to use a collection of functional blocks from Lattice 
Semiconductor. However, Clarity Designer does not only customize intellectual property (IP) but actually creates a 
package of modules. This includes wiring the modules together and creating placement constraints for DDR and PCS 
pins. This package can contain a single module or the entire design. 

The resulting Clarity Designer module can aid in developing the board design and firmware while developing the FPGA 
design, cutting the total development time. 

Clarity Designer features three major tabs: 

 Catalog provides a list of the available modules and IP. Use Catalog to select the modules you want in the project 
and to customize them. You can also download more IP from the Lattice website. 

 Builder helps you make connections between your customized modules. 

 Planner provides a graphic way to place Double-Data Rate (DDR) pins and Physical Coding Sublayer (PCS) 
components before synthesis. You can run design rule checks on the placement while still in the earliest stages of 
designing. 
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Figure 4.12. Clarity Designer Window 

 

For detailed information, refer to the Diamond Software Help and the following sections in the Lattice Diamond 3.12 
User Guide: 

 IPexpress (Chapter 7) 

 Clarity Designer (Chapter 7) 

4.3.3. Schematic Editor 

In the Quartus software, you can use the Schematic Editor to edit or create a schematic design using existing design 
elements from the Intel FPGA libraries, or create your own symbols from HDL or EDA netlist design entities. 

In the Diamond software, you can use also do this using the Schematic Editor, which works in conjunction with Symbol 
Editor and Symbol Library Manager. You design by laying out symbols for basic functions and other modules and 
drawing wires between their ports. You can also create your own library of custom schematic symbols. To begin a new 
schematic design, choose File > New > File. 
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Figure 4.13. Creating a New Schematic File 

When the Schematic Editor window opens, right-click on the window to view options on what you can add to the 
design, such as wires, buses, symbols or ports. 

 

Figure 4.14. Adding Symbols to your Schematic Design 
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Figure 4.15. Example Schematic Design 

For detailed information, see the Entering the Design section of the Lattice Diamond Help. 

4.4. Design Constraints 
Design constraints are used to specify the performance requirements desired for the FPGA design. Various tools help 
the designers to meet those conditions. Constraints are instructions applied to the design elements that guide the 
design toward desired results and performance goals. They are critical to achieving timing closure or managing 
reusable intellectual property (IP). The most common constraints are those for timing and pin assignments, but 
constraints are also available for placement, routing, and many other functions. 

Table 4.2. Design Constraint Tools Comparison 

Intel Quartus Lattice Diamond  

Prime Assignment Editor, Timing Analyzer Text Editor, 
TimeQuest Timing Analyzer 

Lattice Synthesis Engine (LSE) LDC Editor, Synplify Pro SCOPE 
Constraints Editor 

 

Similar to how Intel Quartus applies different constraints, Lattice Diamond is able to apply constraints from mutiple 
sources in multiple ways, such as timing constraints from SDC or LDC synthesis files; constraints defined in HDL source 
files; or with post-synthesis constraints known as logical preferences that are defined in the logical preference file (.lpf). 

Diamond Software provides tools with user interface for assigning constraints: 

4.4.1. Lattice Synthesis Engine (LSE) LDC Editor 
Diamond’s Lattice Synthesis Engine (LSE) enables you to set Synopsys® Design Constraints (SDC), which are directly 
interpreted by the synthesis engine. When you use LSE, these SDC constraints are saved to a Lattice Design Constraints 
file (.ldc). Lattice Design Constraints (LDC) Editor, as well as Source Editor, are available for creating and editing .ldc 
files. LDC Editor provides a spreadsheet style user interface that enables you to quickly create and edit Synopsys Design 
Constraints 
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4.4.2. Synplify Pro SCOPE Constraints Editor 

The SCOPE™ (Synthesis Constraints Optimization Environment) presents a spreadsheet-like editor with a number of 
panels for entering and managing timing constraints and synthesis attributes. The SCOPE user interface also includes an 
advanced text editor that can help you edit constraints easily. These constraints are saved to the FPGA Design 
Constraint (FDC) file. 

Constraints can include timing constraints defined in the synthesis constraint files (SDC) or HDL attributes. SDC is used 
for the synthesis tool. Post-synthesis constraints known as preferences can also be specified. The flow combines these 
together. All three sources of constraints specify design goals. Synthesis, map, and place-and-route work to meet these 
goals. Timing analysis reports whether or not the goals are met. 

Note: Not all existing SDC constraints are supported by Lattice Diamond. 

Synthesis constraint creation flow depends on synthesis tool selection. 

 .ldc (through LSE) 

 .sdc (through Synplify Pro) 

 .fdc (through Synplify Pro) 

 

Figure 4.16. LDC Constraint Editor Window 

 

Figure 4.17. SCOPE Constraint Editor Window 

For Post-synthesis, constraints are stored to the .lpf file, which is used for input for developing and implementing the 
design. The Map Design process depends on the .lpf file. If you map the design and then modify the active .lpf file, the 
map process and any downstream processes must be rerun. 
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You can create and modify logical preferences in the .lpf file using Diamond’s preference-editing views, or you can 
modify the .lpf file directly using a text editor. 

Quartus Assignment Editor provides a spreadsheet-like interface for assigning all instance-specific settings and 
constraints while Lattice Diamond provides similar tools to view and define new constraints, called preferences, or to 
modify existing constraints from the source files and save them as preferences: 
 

 

Figure 4.18. Lattice Diamond Tools 

 Spreadsheet View – Modify timing constraints that are defined in the synthesis tool and save them as logical 
preferences to the active .lpf file. Set timing objectives such as fMAX and I/O timing. Define signalling standards 
and make pin assignments. Assign clocks to primary or secondary routing resources. Set parameters for 
simultaneous switching outputs and perform SSO analysis. Define groups of ports, cells, or ASIC blocks. Create 
UGROUPs from selected instances to guide placement and routing. Establish REGIONs for UGROUPs or to reserve 
areas of the floorplan. Run PIO design rule checking. 

 Device View – Examine FPGA device resources. Reserve sites that should be excluded from placement and routing. 

 Netlist View – View the design tree by ports, instances, and nets. Assign pins for selected signals. Set timing 
constraints. Define groups from selected ports or registers. Create UGROUPs from selected instances to guide 
placement and routing. 

 Package View – View the pin layout of the design. Modify signal assignments and reserve pin sites that should be 
excluded from placement and routing. Examine the status of SSO pins. Run PIO design rule checking. 

 Floorplan View – View the device layout. Draw bounding boxes for UGROUPs. Draw REGIONs for the assignment of 
groups or to reserve areas. Reserve sites and REGIONs that should be excluded from placement and routing. Run 
PIO design rule checking. 

For detailed information, refer to the: 

 Diamond Software Help  

 Sections in the Lattice Diamond 3.12 User Guide: 

 Synthesis Constraint Files (Chapters 5 and 6) 

 LPF Constraint Files (Chapters 5 and 6) 

 Tools: Spreadsheet, Device, Netlist, Package, and Floorplan View (Chapter 7) 

 Lattice Synthesis Engine User Guide 
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4.5. Synthesis 
Similar to Intel Quartus, Lattice Diamond has a proprietary synthesis tool in Lattice Synthesis Engine (LSE) and supports 
a third party synthesis tool in Synplify Pro. 

Table 4.3. Synthesis Tools Comparison 

Intel Quartus Lattice Diamond  

Precision Synthesis, Synplify, and Synplify Pro LSE and Synplify Pro 

 

You can select between available synthesis tools in Quartus by going to the Analysis & Synthesis > Edit Settings > 
Electronic Design Automation (EDA) Tool Settings. In Diamond, you can do this by right-clicking the current 
implementation and then choosing Select Synthesis Tool from the dropdown menu. 

 

 

Figure 4.19. Selecting between Available Synthesis Tools 

In Quartus, synthesis is performed by double-clicking on the Analysis & Synthesis on the Tasks tab. In Diamond, 
synthesis is performed by double-clicking on the Synthesize Design on the Process tab or by right-clicking Synthesize 
Design and then clicking Run on the dropdown menu. 
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Figure 4.20. Running Synthesis on the Process Tab. 

To modify the optimization and other settings related to synthesis, refer to the Design Strategy section. 

http://www.latticesemi.com/legal


Lattice Diamond Design Flow Overview for Intel Quartus Users  
User Guide 
 

© 2022 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.  
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice. 

26  FPGA-UG-02157-1.0 

4.6. Netlist Viewer 
Generated netlist can be viewed in a graphically through one or more schematic views and a browser through which 
you can see the lists of modules, instances, ports, and nets. In Intel Quartus, this can be performed using RTL Viewer 
and Technology Map Viewer. While in Lattice Diamond, this can be performed using Netlist Analyzer of LSE or 
Technology Viewer of Synplify Pro. 

Table 4.4. Tools Comparison 

Intel Quartus Lattice Diamond  

RTL Viewer and Technology Map Viewer Netlist Analyzer and Technology Viewer 

 

To open Netlist Analyzer, click on the Netlist Analyzer icon on the toolbar. 

 

Figure 4.21. Opening Netlist Analyzer 

To open Technology Viewer, open Synplify Pro from the Lattice Diamond and then click on the Technology View icon on 
the toolbar. 

 

 
 

 

 

Figure 4.22. Opening Technology View 

For detailed information, refer to the Diamond Software Help and to the Netlist Analyzer (Chapter 7) in the Lattice 
Diamond 3.12 User Guide: 
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4.7. Design Mapping 
Design mapping converts the logical design into a network of physical components or configurable logic blocks. In Intel 
Quartus, this process is combined with the Analysis & Synthesis process. In Lattice Diamond, this is a separate process 
in the design flow that can be optimized through the design strategy settings. 

To map a design, double-click Map Design or right-click Map Design and select Run from the dropdown menu. 

 

Figure 4.23. Running Map on the Process Tab 

4.8. Place and Route 
After a design has undergone the necessary translation to bring it into the physical design format during mapping, it is 
ready for placement and routing. Placement is the process of assigning the device-specific components produced by 
the mapping process to specific locations on the device floorplan. After placement is complete, the route phase 
establishes physical connections to join components in an electrical network. The place and route process takes a 
mapped physical design and places and routes the design. Placement and routing of a design can be cost-based or 
timing driven. In Intel Quartus software, the Quartus II Fitter, which is also known as the PowerFit Fitter, performs 
place and route, also referred to as "fitting" in the Quartus II software while in the Diamond software environment, the 
Place & Route Design process automatically assigns device-specific components to locations and connects them. 

Table 4.5. Place and Route Tools Comparison 

Intel Quartus Prime Pro Edition Lattice Diamond 

Quartus Fitter  
(Plan, Early Place, Place, Route, Retime and Finalize) 

Place and Route 

 

Placement and routing options can influence the performance and utilization of the design implementation and ease 
incremental design changes. Some options affect the way the results are reported. Experimenting with place and route 
settings in the Strategies dialog box can help improve your placement and routing results. 
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Figure 4.24. PAR Design Strategy Options 

In most cases, your design requires timing-driven placement and routing, where the timing criteria you specify 
influences the implementation of the design. Static timing analysis results show how constrained nets meet or do not 
meet your timing preferences. 

In the Diamond Process view under Place & Route Design, a Place & Route Trace process is available that runs static 
timing analysis on the place and routed .ncd file. This process reports any timing errors associated with preferences 
and generates a report. The Place & Route Trace and I/O Timing Analysis report can be accessed from the Analysis 
Reports folder of the Reports window. These reports help ensure that your I/O plan meets the I/O standards and power 
integrity requirements of the PCB design. 

 

Figure 4.25. PAR Timing Analysis Option 
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4.9. Cross-Probing 
Cross-probing is a feature where it allows the software for seamless bi-directional communication between the 
different tools within the software itself. Users can select a design element from one tool and locate them in another 
tool. Both Intel Quartus and Lattice Diamond software has cross-probing ability. 

Diamond’s preference-editing views allow you to select an element in one view and quickly display the corresponding 
logical or physical element in a different view. For example, you can cross-probe a component in Floorplan View to 
view the logical elements in Netlist View; or you can cross-probe a signal in Spreadsheet View to examine its placement 
on the pin layout of Package View. 

To cross-probe an element from one view to another: 

1. Right-click an element in any view. 

2. Choose Show in and choose the desired view from the pop-up menu. 

Table 4.6 shows the cross-probing availability for each Preference view. 

Table 4.6. Cross-Probing 

Cross Probe From Element Cross Probe To 

Spreadsheet View (Port 
Assignments) 

Pin 

Package View 
Device View 
Netlist View 
NCD View 
Floorplan View 

Spreadsheet View (Pin 
Assignments) 

Signal Package View 

Port Group Package View 

Spreadsheet View (Group) Anchored UGROUP Floorplan View 

Spreadsheet View (Misc) REGION Floorplan View 

Package View 

Assigned pin 

Netlist View 
Spreadsheet View             
Floorplan View 
Device View 

Site 
Floorplan View 
Device View 

Device View 

DQS, IOL, PFF, PFU, PLL/DLL, 
DCC/DCS, sysDSP, sysMEM 

Floorplan View 
Physical View 

Others: GSR, JTAG, Oscillator, etc. 
Floorplan View 
Physical View 

Assignable PIO Cell 
Package View 
Floorplan View 
Physical View 

Unassignable PIO Cell 
Floorplan View 
Physical View 

DDR Support with bonded DQS 
Package View 
Floorplan View 
Physical View 

Netlist View 

Assigned port Package View 

Instance 
Floorplan View 
Physical View 
NCD View 

Net 
Floorplan View 
Physical View 
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Cross Probe From Element Cross Probe To 

NCD View 

IOL instance, PCS block, PFF slice, PFU slice, 
PLL/DLL, sysDSP block, sysMEM block, 

Netlist View 
Floorplan View 
Physical View 

User PIO 

Netlist View 
Package View 
Floorplan View 
Physical View 

Others: GSR, JTAG, Oscillator, etc., Net 
Floorplan View 
Physical View 

Floorplan View 

Assignable PIO site 
Device View 
Physical View 
Package View 

Placed PIO 

Device View 
Netlist View 
NCD View 
Physical View 
Package View 

Placed IOL 

Device View 
Netlist View 
NCD View 
Physical View 

Any non-PIO site 
Device View 
Physical View 

Any non-PIO placed component 
Note: To cross-probe PFF or PFU 
components, select individual slices. 

Device View 
Netlist View 
NCD View 
Physical View 

Port Physical View 

UGROUP, REGION Spreadsheet View 

Physical View 

Site 
Device View 
Floorplan View 

Placed component 

Device View 
Netlist View 
NCD View 
Floorplan View 

Net 
NCD View 
Floorplan View 
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4.10. Programming Files 
After you have created and verified your design, you can use the final output data file to download or upload a 
bitstream to or from an FPGA device using the Diamond Programmer. The bitstream file contains all of the 
configuration information from the physical design that define the internal logic and interconnections of the FPGA, as 
well as device-specific information from other files associated with the target device 

Bitstream generation is automatically performed when you run the Bitstream File process for a full design flow or a 
partial design flow. 

Table 4.7. File Formats 

File Format Description 

Bit File (binary) (.bit) Binary bitstream files are the default output of the bitstream process and contain the 
configuration information in bitstream (zeroes and ones) that is represented in the 
physical design (.ncd) file 

Raw Bit File (ASCII) (.rbt) The Raw Bit File is a text file containing ASCII ones and zeros representing the bits in the 
bitstream file. If you are using a microprocessor to configure a single FPGA, you can 
include the Raw Bit file in the source code as a text file to represent the configuration 
data. The sequence of characters in the Raw Bit file is the same as the bit sequence that 
is written into the FPGA. The .rbt file differs from the .bit file in that it contains design 
information in the first six lines 

Hex Mask File (.msk) Used to compare relevant bit locations for executing a read back of configuration data 
contained in an operating FPGA. 

Bit Generation Report File (.bgn) Outputs information on a bit generation (bitgen) run and displays information on 
options that are set. This file is output by default and given the name, 
design_name>.bgn 

 

For more information, you can refer to Diamond Help or to the following sections in the Lattice Diamond 3.12 
Programming Tools User Guide. 

 Programming Files (Chapter 5) 

 Programmer (Chapter 7) 
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4.11. Reports 
In Intel Quartus, you can view the reports of each step in the Task View by clicking on View Report. In Lattice Diamond, 
you can click on the Reports tab, which is open by default on the Diamond workspace. Otherwise, you can go to View > 
Reports. 

Each step on the design flow have their own set of reports from resource usage to timing analysis. 

 

Figure 4.26. Reports Tab 

For more information you can refer to Diamond Help or to the following sections in the Lattice Diamond 3.12 User 
Guide: 

 Reports (Chapter 4) 

 Reports (Chapter 7) 
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5. Design Verification Tools 

5.1. Simulation 
Intel Quartus and Lattice Diamond both support a number of third-party simulators, as shown in Table 5.1. 

Table 5.1. Supported Simulators 

Intel Quartus Lattice Diamond  

Aldec Active-HDL, Aldec Rivera-PRO, Cadence Incisive, Synopsys 
VCS, Questasim, and Mentor Graphics Modelsim 

Synopsys VCS, Cadence NC-Verilog, Cadence NC-VHDL, 
Cadence NCSim, Aldec Riviera Pro, Aldec Active-HDL, 

Questasim, and Mentor Graphics Modelsim 

 

In Quartus, you can run a simulation through the Tasks tab by Selecting the RTL or Gate-Level Simulation. In Diamond, 
you can click on the Simulation Wizard icon to run simulation using Modelsim, which is a directly linked third-party 
simulator. 

 

Figure 5.1. Opening Simulation Wizard from the Toolbar 

Lattice Diamond also comes with a standalone version of ModelSim that can be used for project simulation. For details 
on performing simulation using the third-party simulators, refer to the Third-Party Simulators section of the Diamond 
Help. 

5.1.1. Simulation Levels 

Depending on the output files chosen on the Process toolbar, you can perform different simulation levels. In Quartus, 
there are only two simulation levels: the RTL and the gate-level simulations. In Diamond, there are three simulation 
levels: the RTL, the post-route gate-level, and the post-route gate-level+timing simulations, which give you more 
options when simulating designs before performing hardware verification. 

You can choose between the simulation levels on the Process Stage of the Simulation Wizard window. 

 

Figure 5.2. Simulation Wizard Window Showing the Simulation Levels 
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Each of these simulation requires specific output files that can be generated on the design flow before it can be 
performed: 

 RTL Simulation — This can be run with just an HDL file and a testbench file. 

 Post-Route Gate-Level — Aside from an HDL file and a testbench file, a map gate-level netlist file and standard 
delay format file (SDF) are needed which are generated during the Map Design process when Verilog (or VHDL) 
Simulation File is ticked. 

 Post-Route Gate-Level+Timing — Aside from an HDL file and a testbench file, a post PAR gate-level netlist file and 
an SDF are needed which are also generated during the Export Files process when Verilog (or VHDL) Simulation File 
is ticked. 

 

Figure 5.3. Generating a Post-Synthesis Simulation File 

For detailed information, refer to the Diamond Software Help and the following sections in the Lattice Diamond 3.12 
User Guide: 

 Simulation Flow (Chapter 6) 

 Simulation Wizard (Chapter 7) 

 Mentor ModelSim (Chapter 7) 

 Compile Lattice FPGA Simulation Libraries (Chapter 8) 
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5.2. Static Timing Analysis (STA) 
Similar to the Timing Analyzer in Intel Quartus, Lattice Diamond TRACE analyses timing preferences that are present in 
the logical preference file (LPF). These timing constraints are defined in the Timing Preferences sheet of the 
Spreadsheet View or in a text editor and applied to the design before the design is mapped.  

A TRACE report file, which shows the results of timing preferences, is generated each time you run the Map Trace 
process or the Place & Route Trace (PAR) process. The results can then be viewed in the Report View window. The Map 
TRACE report (.tw1) contains estimated routing that can be used to verify the expected paths and to provide an 
estimate of the delays before you run Place & Route. The PAR TRACE report (.twr) contains delays based on the actual 
placement and routing and is a more realistic estimate of the actual timing. 

Timing Analysis View is a graphical view of the post-route TRACE report. It provides path tables, schematic views of 
timing paths, and a report of each timing preference. It also allows you to cross-probe to Floorplan View or Physical 
View to see where these paths exist on the chip. 

 

Figure 5.4. Opening the Timing Analyzer Tab 

 

Figure 5.5. Timing Analysis View 

For detailed information about TRACE and Timing Analysis View, see Analyzing Static Timing in the Diamond Software 
Help and the following sections in the Lattice Diamond 3.12 User Guide: 

 Timing (Chapter 5) 

 Timing Analysis View (Chapter 7) 
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5.3. On-Chip Hardware Debugging using Reveal 
The final stage of developing the design is the actual verification process either on a test board or in your system. The 
on-chip debugging tools allow live hardware aspect checking in your design, which helps to quickly do a verification 
without the use of any external equipment. 

While Intel Quartus software offers multiple portfolios of on-chip debugging tools, in the Diamond software 
environment, the LatticeMico Debugger and the Reveal Analyzer/Controller tools continuously monitor signals within 
the FPGA for specific conditions, which can range from simple to complex. These tools observe what is happening 
inside the FPGA and even change register values while your system is running. 

 LatticeMico Debugger to debug LatticeMico32 microprocessor software 

 Reveal Analyzer to check for and to analyze specific events on signals 

Lattice Diamond also provides sample designs to get some hands-on experience with the Reveal tools. To access these 
examples, click File > Open > Design Example and choose the design with reveal on the project name. 

While LatticeMico Debugger and Reveal Analyzer work independently, they can run at the same time. Before you start 

debugging, each tool requires that a special interface module be added to the design. You can then rerun the design 

implementation process (Synthesize Design, Translate Design, Map Design, Place & Route Design) and generate a 

bitstream data or a JEDEC file (depending on the device family) to program the FPGA. The tools can share the same 

ispDOWNLOAD cable and JTAG port that Programmer uses to download the design. 

For detailed information, refer to the following existing documentations on using Reveal: 

 Reveal Troubleshooting Guide  

 Lattice Diamond 3.12 User Guide 

 Reveal Inserter (Chapter 7) 

 Reveal Analyzer (Chapter 7) 

Note: LatticeMico Debugger does not support the LatticeMico8 microcontroller. 

5.4. Power Analysis 
Similar to Intel Quartus’ Power Estimator (EPE) and Power Analyzer tool, Diamond offers the Power Calculator, which 
estimates the power dissipation for a given design. 

Table 5.2. Power Analysis Tools Comparison 

Intel Quartus Lattice Diamond 

Power Estimator (EPE) and Power Analyzer tool Power Calculator 

 

Power Calculator uses parameters such as voltage, temperature, process variations, air flow, heat sink, resource 
utilization, activity, and frequency to calculate the device power consumption. It reports both static and dynamic 
estimated power consumption. The tool also allows you to import frequency and activity factors from the post-PAR 
simulation value change dump file (.vcd file). After the design information is added, Power Calculator provides accurate 
power consumption analysis for the design. 

Power Calculator provides two modes for reporting power consumption: 

 Estimation mode is used before completing the design. 

 Calculation mode is based on the physical netlist file (.udb) after placement and routing. 
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Figure 5.6. Power Calculator 

For detailed information refer to the Diamond Help or to Power Calculator (Chapter 7) in the Lattice Diamond 3.12 User 
Guide. 
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6. TCL Scripting 
Similar to Intel Quartus, Lattice Diamond also support TCL (Tool Command Language) scripting feature that enable a 
batch capability for running tools in the Diamond software’s graphical interface. TCL commands can be used through 
the command line/terminal or the Lattice Diamond Stand-Alone TCL console that is included in the software package. 
The command set and the TCL Console used to run it affords you the speed, flexibility and power to extend the range of 
useful tasks that the Diamond software tools are already designed to perform. 

Using the command line tools allows you to do the following: 

 Develop a repeatable design environment and design flow that eliminates setup errors that are common in GUI 
design flows 

 Create test and verification scripts that allow designs to be checked for correct implementation 

 Run jobs on demand automatically without user interaction 

Note: The environments for both the Diamond TCL Console window or Diamond Standalone TCL Console window are 
already set. You can start entering TCL tool commands or core tool commands in the console and the software 
executes them.  

When running the Diamond software from the Windows command line (through cmd.exe) or Linux terminal (bash), you 
need to set up the environment variables as stated in the Setting Up the Environment to Run Command Line section of 
the Lattice Diamond software Help. 

For detailed information refer to the Diamond Help or to Chapter 9 in the Lattice Diamond 3.12 User Guide. 
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7. Platform Designer Tool 
Diamond includes the Platform Designer tool, which enables you to build and control a complete hardware 
management system. Platform Designer provides an integrated design environment that enables you to configure the 
device, implement the hardware management algorithm, simulate, assign pins, and finally generate the JEDEC files 
required to program and configure the device on the circuit board. It also allows you to import other HDL files to 
integrate other desired functions 

Lattice devices supported in Platform Designer: 

 Platform Manager 2 

 Platform Manager 2 in a two-device (LPTM21 and LPTM21L) configuration 

 Certain devices in the MachXO2 HC/HE family with external Analog Sense and Control (ASC) devices 

 Certain devices in the MachXO3D family with external ASC devices 

 Certain devices in the MachXO3LF family with external ASC devices 

 Certain devices in the ECP5 family (LFE5U/LFE5UM) with external ASC devices 

 The larger LPTM21 device can configure both ASC and/or LPTM21L as slave devices. 

 

Figure 7.1. Platform Designer User Interface 

For detailed information, refer to the Lattice Diamond 3.12 Platform Designer User Guide. 
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8. Lattice Propel 
Lattice Propel is a design environment for Lattice FPGA-based processor system designs. Its development suite 
includes: 

 Integrated development environment (IDE) 

 Lattice Propel Builder graphical user interface for System-on-Chip (SoC) design 

 Lattice Propel Software Development Kit (SDK) for system software development based on Eclipse Embedded 
C/C++ Development tools (CDT) 

The Lattice Propel flow starts with the creation on an SoC system design in Lattice Propel Builder using the RISC-V CPU 
together with APB and AHB-L buses, and peripherals. 

 

Figure 8.1. Lattice Propel Builder Design Flow 

A C/C++ project is then created using the environment file of the SoC design. User can then input their executable code 
on the SoC design as part of the RTL. Typically, this process can be done by loading the memory file on the system 
memory of the SoC design. 

The next step is to generate the RTL files and then go through the design flow using Lattice Diamond or Lattice 
Radiant™ Software. Once the configuration is loaded onto the SRAM. Design can be verified through Reveal or through 
GNU debugger of the SDK. 

 

Figure 8.2. Lattice Propel Design Environment 

For detailed information on Lattice Propel, you can find all materials on the Lattice Propel Page. 
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